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Introduction

This document is the installation and operation manual for VideoXpert v 3.x Occupancy Counting Service.

System Overview

VxOpsCenter

e
)

Occupancy Configurator

Occupancy Counter
Flugin

Occupancy Counter
Dashboard

LI P ——

The Occupancy Counting Service is comprised of three components:

« The Occupancy Counting Configuration application provides the ability to configure regions with IN
and OUT lines over Pelco cameras that support advanced analytics, to determine the occupancy of
that region. The Occupancy Counting Configuration application can be installed on any system
mentioned in Installing Prerequisites, if it can successfully connect to the VideoXpert System.

« The Occupancy Counting Dashboard provides live and historical data of the occupancy count. Itis a
standalone application for use by administrators as well for display purposes.

o The Occupancy Counting Plugin is a VxOpsCenter plugin that also displays live and historical data
of the occupancy count. It is an VxOpsCenter-dependent plugin for use by Operators.

2] Note: Occupancy Counting components (Configuration, Dashboard, and Plugin) are supported with
VideoXpert version 3.11.x and above.
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Installing the Software

Installing Prerequisites
Prior to installation of this software, install the following:
o Windows 7, Windows 8.1, Windows 10
« VideoXpertPro-3.11.x
« VideoXpertCore-3.11.x
o VidepXpertOpsCenter-3.11.x
The Occupancy Counting Service software will install any needed prerequisites, including:

o .NET Framework 4.7.2 or later
« Microsoft Visual C++ 2015 Redistributables (x64)

Installing the Occupancy Counter
1. Right-click the OccupancyCounting-1.x.x.xx file, and then start the installation as an administrator.

2. Click Install.

9 Occupancy Counter Setup — *

Occupancy Counter

Welcome

Setup will install Occupancy Counter on your computer. Click install to
continue, options to set the install directory or Close to exit.

E;lnstall Close

3. Click Install.
4. If necessary, click Cancel to abort the installation.
5. Click Close.

Installing the Occupancy Counter Dashboard

1. Right-click the OccupancyDashboard-1.x.x.xx file, and then start the installation as an
administrator.
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2. Click Next.

9 Occupancy Counter Dashboard Setup — *

Occupancy Counter Dashboard

Welcome

Setup will install Occupancy Counter Dashboard on your computer. Click
install to continue, options to set the install directory or Close to exit.

E;lnstall Close

3. Click Install.
4. If necessary, click Cancel to abort the installation.
5. Click Close.

Installing the Occupancy Counter Plugin

1. Double click the OccupancyPlugin-1.x.x.xx file to start the installation.
2. Click Install.

9 Occupancy Counter Plugin Setup — *

Occupancy Counter Plugin

Welcome

Setup will install Occupancy Counter Plugin on your computer. Click install
to continue, options to set the install directory or Close to exit.

E;lnstall Close

3. Click Close.
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Licensing the Occupancy Counting Service

The Occupancy Counting Service requires a license to be present on each VideoXpert system that will be
added toiit. If alicense is not present on the system when it is added, a 90-day trial period will begin on that
system. The Occupancy Counting Service will be able to use the system normally during this period. If the
system remains unlicensed when the trial period expires the Occupancy Counting Service will no longer be
able to communicate with the system until a valid license has been applied.

For assistance, contact Pelco Product Support at 1-800-289-9100 (USA and Canada) or +1-559-292-1981
(international).

Configuring and Using the Software

Configuring the Occupancy Configurator

1. Afterinstalling the Occupancy Counter, start the application. This will open the Occupancy
Configurator.

2. Type inthe VideoXpert Server information.

Occupancy Configurator

a. Enteravalue inthe Host field. This is the IP address of the VideoXpert Core or VideoXpert
Professional.

c

Update the Port, if necessary. The default port is 443.

o

Enter the Username and Password, which are the credentials for any VideoXpert user with an
administrator role.

o

E, Note: Only a VideoXpert user with an administrator role can configure occupancy
S settings; however, any VideoXpert user can view occupancy data in the plugin, on the
dashboard, or on a web page.

e. Click Save.

3. After the connection is successfully made and the status shows as Connected with a green
checkmark icon, click Continue.

Caution: Before configuring the regions for Occupancy Counting, configure person counters
(advanced analytics) via VideoXpert Toolbox on the cameras. See the current version of the
VideoXpert Toolbox Operations Manual for adding person counters.
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4. Add regions.

Regions identify one or more person counters across multiple cameras supporting advanced
analytics. In the Regions (left) panel:

a. Click the Add () icon.

b. Entera user friendly name for the region.
c. Afteraregionis added, add IN and OUT lines.

« These lines will automatically pop up if the person counters are correctly configured on the
camera (from VideoXpert Toolbox).

« Currently, Occupancy Counter supports only Uni-Directional lines. During configuration,
the user must create IN and OUT counters separately.

« A single region can contain multiple lines with multiple cameras.

& Note: Save each individual region separately, by clicking Save. After all of the regions and
lines are configured, you will click Done to push the configuration changes.

5. (Optional) To delete an added region, click the Delete ([ii]) icon.

6. Configure the IN and OUT Counters for each region.
a. Click to select the region name.
In the right panel, in the Counters area, click the Edit ) icon in the /n heading to open the Edit

"In" Counters for Region window.

c. Click to select and deselect the checkboxes for the IN counters, and then click Save. Each
IN counter counts the persons entering the region.

BRIl Edit "In" Counters for Region
Building 1

Selected Lines Available Lines 8

Building 1

4[] IP Camera - IME338-1IRS - TSBJ71018261
[] Main Door OUT

LA ez (LY North Door IN

1P Camera - INE338-1IRS - TSEIT1018261 [] Back Door OUT

North Door IN [ North Door oUT

1P Camera - IME338-1IRS - TSBJ71018261 Main Door IN

Side Door IN

Back Door IN

[] Side Door OUT

407 & Selected

Cancel

d. Inthe right panel, in the Counters area, click the Edit ) icon in the Out heading to open the
Edit "Out" Counters for Region window.

e. Click to select and deselect the checkboxes for the OUT counters, and then click Save. Each
OUT counter counts the persons exiting the region.
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7.

10.

(Optional) Configure Event Thresholds for each region.

You can configure events to be received by the VxOpsCenter Event Viewer if occupancy thresholds
are exceeded. Events are configured in VxToolbox. Events can be triggered when the capacity goes
over or under the specified value. The user can specify a friendly label which will be shown in the
Events plugin in VxOpsCenter when the event is received.

a. If you have not already done so, click to select the Region.

b. Intheright panel, in the Event Thresholds area at the far right of the heading, click the Edit
) icon to open the Edit Event Thresholds for Region window.

c. Click the Add (<=) icon, and then select and type in values for the Trigger if capacity is and
Event Label fields.

Edit Event Thresholds for Region &3

Building 1
Building 1 Over Occupancy

Event label | Building 1 Under Occupancy

+ | o
Cancel

d. If appropriate, add more event thresholds.
e. Afteryou have added all of the event thresholds, click Save.

(Optional) Reset the Total In and Total Out counts.

To obtain daily occupancy counts, reset the totals each day.
a. If youhave not already done so, click to select the Region.
b. Under Total Inand Total Out, click Reset Totals.

(Optional) Reset Occupancy.

a. If you have not already done so, click to select the Region.
b. Under Occupancy, click Reset Occupancy.

Set the appropriate value in the Occupancy field.

In most cases, you will set this value to zero (0); but when appropriate, you can set this to a different
value. For example: you can set the occupancy to the number of employees in the region before any
visitors enter or exit.

a. If you have not already done so, click to select the Region.
b. Under Occupancy, type a value in the Occupancy field.
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11. (Optional) Customize browser images to be opened on the system's default browser for display
purposes. You can use your own logo, the over or under occupancy status, and the total number of
occupants.

If you have not already done so, click to select the Region.

b. Inthe BrowserImages area, click Browse to the right of the Under Capacity field, navigate to
the appropriate image file, and then double-click it.

c. Inthe BrowserImages area, click Browse to the right of the Over Capacity field, navigate to
the appropriate image file, and then double-click it.

d. Click Open Browser to log in to the VideoXpert System and preview the display.

An example Under Capacity image is as follows.

’j Please Come In

5
1\, 0/20
occupants

An example Over Capacity image is as follows.

G Please Wait

57120
p occupants

12. Click Save Changes.
13. Click Done.

Configuring the Occupancy Counter Dashboard

Occupancy Dashboard is a standalone application used to connect to the Occupancy Counter
Configuration application for displaying occupancy from various regions live as well as to view historic data
by choosing the timeline. After installation, start the Occupancy Dashboard application and connect it to
the Occupancy Counter Configuration application.

Caution: Complete the procedure in Configuring the Occupancy Configurator before using the
dashboard. The Occupancy Counter Dashboard can be installed on a standalone system, if it is able
to connect to the Occupancy Counter Configuration application.

1. Start the Occupancy Dashboard.

2. Typein the Occupancy Counter Configuration application information.
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rd

Total Occupancy v+ %%

Endpoint Info

system Credentials

a. Enteravalue in the Hosftfield. This is the IP address of the system on which the Occupancy
Counter Configuration application is installed and running.

b. Update the Port, if necessary. The default port is 5443.
c. Enterthe Username and Password, which are the credentials for any VideoXpert user with an
adminisrator role.

E, Note: Only a VideoXpert user with an administrator role can configure occupancy
S settings; however, any VideoXpert user can view occupancy data in the plugin, on the
dashboard, or on a web page.

d. Click Save.

3. After the connection is successfully made and the status shows as Connected with a green
checkmark icon, click Continue.

4. (Optional) View live (current) occupancy information.
a. Click the Live tab.

The Live page shows the current status of occupancy along with Total In and Total Out data for
that region. Occupancy is displayed using a graph plotted against time and also using an
occupancy count dial.

Total Occupancy v %

10:39:06 AW
Occupancy: 14
.

C6687M-A | 02/21 10



VideoXpert™ v 3.x Occupancy Counting Service Installation and Operations Manual

b. From the drop-down menu to the left of the settings (EI) icon, click to select Total Occupancy
or another region for which to view live occupancy data.

c. (Optional) Type a value in the Set Occupancy field and then click Set Occupancy to manually
enter an occupancy value.

d. (Optional) Click Reset Occupancy to set the occupancy value to zero (0).
e. (Optional) Click Reset Totals to set the occupancy totals values to zero (0).
5. (Optional) Review and export historical occupancy data.

a. Click the Review tab.

1/15/2021-1/15/2021

b. Select a date and time range for the historical data, by one of the following methods:

« Enterorselect values in the start date, start time, end date, and end time fields to specify
the occupancy data included on the page.

« Click and drag the blue bars on the blue vertical lines to the appropriate start and end dates
and times.

c. Click Update.

d. (Optional) Click Export, and then follow the prompts to export the file in .csv format.

Configuring the Occupancy Counter Plugin

The Occupancy Counter Plugin is a plugin for VxOpsCenter which displays the occupancy count for
defined regions. See the current version of the VideoXpert OpsCenter Operations Manual.

Caution: Occupancy Counter Configuration must be completed before the Occupancy Counter
Plugin can be used. The Occupancy Counter Plugin must be installed on the system on which
VxOpsCenter is installed.

1. Launch VxOpsCenter.
2. Access the available plugins by one of the following methods:
« InMission Control (right panel), click to expand Content, and then click the Plugins tab.

« In Mission Control (right panel), click the Plugins icon ().

3. If necessary, click to expand Content Plugins.

C6687M-A | 02/21
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4. Double-click the Occupancy Counting plugin to add it to the selected cell (if you selected a cell), or
drag the plugin to any cell.

5. Type in the Occupancy Counter information.

C.

Enter a value in the Host field. This is the IP address of the system on which the Occupancy
Counter Configuration application is installed and running.

Update the Port, if necessary. The default port is 5443. This must be the same port that is used
for the Occupancy Counter Configuration application.

Click Save.

After the connection is successfully made, the status shows as Connected with a green checkmark
icon.

6. (Optional) View live (current) occupancy information.

a.

Click the Live tab.

The Live page shows the current status of occupancy along with Total In and Total Out data for
that region. Occupancy is displayed using a graph plotted against time and also using an
occupancy count dial.

From the drop-down menu to the left of the settings ([ﬂ) icon, click to select Total Occupancy
or another region for which to view live occupancy data.

(Optional) Type a value in the Set Occupancy field and then click Set Occupancy to manually
enter an occupancy value.

(Optional) Click Reset Occupancy to set the occupancy value to zero (0).

(Optional) Click Reset Totals to set the occupancy totals values to zero (0).
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7. (Optional) Review and export historical occupancy data.

a. Click the Review tab.

b. Select a date and time range for the historical data, by one of the following methods.

« Enter or select values in the start date, start time, end date, and end time fields to specify
the occupancy data included on the page.

« Click and drag the blue bars on the blue vertical lines to the appropriate start and end dates
and times.

c. Click Update.
d. (Optional) Click Export, and then follow the prompts to export the file in .csv format.

The advantage of using the Occupancy Counting plugin is that the user can view the camera which is using
the person counters in one cell of VxOpsCenter, and view the live or historic data in another cell.

Troubleshooting

Log files for the middleware are located at C:\ProgramData\Pelco\Logs\OccupancyCounting.

Pelco Troubleshooting Contact Information

For further assistance, contact Pelco Product Support at 1-800-289-9100 (USA and Canada) or +1-559-
292-1981 (international).
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Version Information

Integration Component Version

Component Name Version Description
OccupancyCounting-1.0.3.x 1.0.3.x Occupancy Configurator
OccupancyPlugin-1.0.3.x 1.0.3.x Occupancy Counter Plugin
OccupancyDashboard-1.0.3.x 1.0.3.x Occupancy Counter Dashboard
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